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Math2Model ist ein Werkzeug, das die Darstellung von mathematischen Funktionen in
parametrischer Form in Echtzeit ermoglicht. Es erlaubt es somit, mathematische Funktionen im
parametrischen Format zu rendern. Zwei Benutzeroberflachen werden unterstiitzt: Eine fiir
Programmierer, in der diese mathematischen Objekte mittels Quellcode beschreiben konnen,
und eine weitere Benutzeroberflache fiir Nicht-Programmierer, die parametrisches Modellieren
uber einen Node-Editor ermoglicht.

Das Projektziel war, parametrische Modellierung in Echtzeit im Browser zu ermoglichen.
Parametrische Modellierung ist ein gangiges Tool unter Architekten, 3D-Modellierern,
Spieleentwicklern oder auch Kiinstlern, um schone Formen iber Mathematik zu erzeugen. Auch
ein Einsatz unseres Tools in der Forschung ist denkbar. Ein einfach und v.A. schnell zu
verwendendes Onlinetool in diesem Bereich gab es bislang noch nicht in dieser Form.
Math2Model ist das erste derartige Tool, das Live-Modellierung uber mathematische Formeln in
Echtzeit im Browser ermdglicht, wobei sich ,,Echtzeit* auf die Anderungen am Modell in Echtzeit -
d.h. ohne merkliche Wartezeit - bezieht.

Typische Probleme von anderen Tools in dieser Hinsicht waren die Wartezeit auf die Ergebnisse
(d.h. Ergebnisse waren nicht in Echtzeit sichtbar) oder die Erfordernis von (teils teuren)
spezialisierten Tools. Modellierung im Browser war bis vor kurzem nur schwer moglich aufgrund
von technischen Limitierungen.

Durch technischen Fortschritt in Browsern (genauer gesagt durch eine neue
Programmierschnittstelle namens ,,WebGPU") vor ca. 2 Jahren wurden neue technische
Moglichkeiten geschaffen, die es erlauben, viel machtigere Webapplikationen zu bauen. Und
diese technische Weiterentwicklung ist auch Voraussetzung fiir unser Onlinetool, da der
zugrundeliegende Algorithmus sogenannte ,Compute Shader® bendétigt, die WebGPU nun auch
im Web anbietet.

Die Ergebnisse unserer ca. 1,5-jahrigen Arbeitszeit an diesem Projekt sind:

e Ein publiziertes Paper, das einen passenden Algorithmus beschreibt, um parametrisch
definierte mathematische Modelle in Echtzeit mit hoher Framerate und hoher
geometrischer Prazision zu rendern.

e Ein frei verfligbares Onlinetool, das den publizierten Algorithmus implementiert und
folgende Features bietet:

o Direkter Einstieg in die Modellierung tiber ein einfaches Webinterface
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o Parametrische Modellierung tiber Sourcecode direkt im Browser flir User, die mit

Scripting oder Coding vertraut sind.

o Parametrische Modellierung tiber ein einfacheres Graphen-basiertes Interface, das
diverse Hilfestellungen fiir technisch weniger versierte Nutzer bietet.

o Exportder modellierten Formen in 3D Formate, um sie auch in anderen gangigen
Programmen nutzen zu kdnnen (wie z.B. Spieleengines)

e Source Code und Dokumentation werden frei bereitgstellt.

3 Verlauf der Arbeitspakete

Das folgende Diagramm zeigt den aktualisierten Uberblick tiber die Arbeitspakete und in welchen
Monaten primar an diesen gearbeitet wurde:

Janner 2024 Marz 2024 Mai 2024 Juli 2024 Sept. 2024  Nov. 2024  Jinner 2024 Marz 2025 April 2025

3.1  Arbeitspaket 1 - Detailplanung und Formales am Projektstart

Notige Unterlagen zur Beantragung von Forderrate 1 wurden zusammengestellt und Gbermittelt.
Im Zuge dessen haben wir uns auf ein neues Arbeitspaket geeinigt: AP9. Der Vertrag wurde
unterschriegen, der Detailprojektplan erstellt und abgenommen.

Die Projektwebsite haben wir im Laufe der Entwicklungen schlussendlich auf GitHub Pages
gehostet, was sehr gut mit unterschiedlicher Nutzerlast skalieren sollte. Ebenso konnten wir
automatisches Deployment aus dem Coderepository dorthin einrichten.

Hier die Adresse der Website: https://math2model.cg.tuwien.ac.at/

3.2  Arbeitspaket 2 - Grundlegendes Projektsetup
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Die Haupttatigkeit dieses Arbeitspakets bestand darin, die technologische Basis unseres Onlinetools zu
definieren. Dabei wurden eine Vielzahl von JavaScript-Frameworks ausprobiert.

Erkenntnisse wurden in folgenden beiden Blog Posts beschrieben:
e Entscheidungen hinsichtlich technologischer Basis

e WGSL - Die neue Shadersprache

Es gab dabei durchaus auch diverse Probleme - vor allem hinsichtlich des verwendeten
Renderingframeworks Babylon.js. Es bietet eine Vielzahl an hilfreichen Funktionalitaten, doch
wirft es auch Probleme auf, sodass wir immer wieder evaluieren mussten, ob es nicht
zielfiihrender ware, Math2Model ohne ein groRes Renderingframework zu entwickeln, sondern
mittels direkter Verwendung der low-level APl WebGPU.

Schlussendlich entschieden wir uns dann tatsachlich noch relativ spat - namlich ziemlich genau
in der Mitte der Projektlaufzeit - fir einen Technologiewechsel auf direkte Verwendung der
WebGPU-Schnittstelle, die wir einerseits Uiber TypeScript - aber andererseits auch tber die
Programmiersprache Rust bedienen kénnen. Diese Vorgehensweise (sowohl TypeScript als auch
Rust) hat Vor- und Nachteile. Zu den Vorteilen zdhlen die hohe Flexibilitat fiir Entwickler sowie die
Moglichkeit, GPU-Profiling-Tools verwenden zu konnen - als Nachteile ist vor Allem die erhohte
Komplexitat des Projekts aus Entwicklersicht sowie das leicht kompliziertere Projektsetup zu
nennen.

Rust ist eigentlich eine Desktopprogrammiersprache, die aber mittels WebAssembly in ein
Browserproramm ubersetzt und somit dafur genutzt werden kann. Weitere Details haben wir in
diesem Blogpost beschrieben:

e Browserprogrammierung mit einer "Desktop-Programmiersprache"

3.3 Arbeitspaket 3 - Effiziente Renderingtechnik fiir beliebige parametrische Funktionen

AP3 bezieht sich nun rein auf die Entwicklung einer effizienten Renderingtechnik fiir parametrisch
definierte Objekte. Dieses wurde zunachst als eigenstandige Desktopapplikation entwickelt, getestet,
evaluiert und bei einer internationalen Konferenz eingereicht. Verwandt dazu ist AP7: Es bezieht sich
darauf, die Renderingmethode in unser Onlinetool zu portieren und dort verwendbar zu machen.

Unsere Vorgehensweise, die Technik zuerst als Desktopapplikation zu entwickeln hat den grofien Vorteil,
dass wir alle Funktionalitaten von Graphikkarten nutzen konnten, um die effizienteste Variante der
Renderingtechnik zu entwickeln. Die Browserbasierte WebGPU-Schnittstelle ist hinsichtlich verfligbarer
Funktionalitaten etwas limitiert, was daran liegt, dass sie hochstmogliche Kompatibilitat flir Web-fahige
Gerate ermoglichen will.

Wir konnten AP3 vollstandig abschlieRen. Unsere effiziente Renderingmethode wurde von internationalen
Reviewern begutachtet, zum The Eurographics Symposium on Parallel Graphics and Visualization (EGPGV)

zugelassen, dort prasentiert und mit dem Best Paper Award ausgezeichnet. Das Paper wurde bereits von

The Eurographics Association publiziert.

Weitere Details zur verwendeten Renderingtechnik sind in diesem Blogpost beschrieben:
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e Publikation unserer Renderingtechnik

3.4  Arbeitspaket 4 - Umwandlung der gerenderten parametrischen Funktionen in 3D
Modelle

Beschreibung der Geometrie eines Objektes tiber Mathematik ist zwar eine sehr elegante Form
und auch sehr speichereffizient, da eben nur die mathematische Formel benétigt wird -
allerdings ist diese Beschreibung der Geometrie auch mitunter unpraktisch, da sie von
klassischen Graphiktools nicht unterstiitz wird.

Wahrend unser Tool die mathematischen Funktionen direkt darstellen kann, bendtigt es
mitunter andere Formate, um die so erzeugte Geometrie auch in anderen Tools verflighar zu
machen. Klassisischerweise wurde und wird 3D-Geometrie liber 3D-Modelle ausgetauscht. Dafur
gibt es eine vielzahl an gangigen Formaten. Zwei der gangigsten Formate sind OBJ und glTF. Wir
haben uns dafiir entschieden, diese beiden zu unterstiitzen, da sie sehr gangig und offene
Standards sind.

Die Herangehensweise beim Exportieren der 3D-Modelle ist eine etwas andere als bei der
Darstellung am Bildschirm, das eine Anderung am grundlegenden Algoithmus erfordert: Anstatt
den Detailgrad der Geometrie adaptiv zum Bildausschnitt anzupassen, wird der Detailgrad
uniform gesetzt und so exportiert.

Herausforderungen bei diesem Schritt waren die Auswahl von passenden 3D-Formaten und
Implementierung des Exports, sowie das Finden passender Export-Einstellungen. Schlussendlich
haben wir einige Exporteinstellungen konfigurierbar gemacht, sodass User diese an ihre
Anforderungen anpassen konnen.

In Summe hat die Entwicklung deutlich [anger gedauert als geplant - vor Allem wegen dem
Finden passender Exporteinstellungen, Verhindern dass exportierte Meshes nicht mehr
zusammenhangen und auch wegen technischen Limitierungen hinsichtlich WebGPU, welches
Beschrankungen fur die maximale BuffergrofRe mit sich bringt. Schlussendlich konnten wir

3.5 Arbeitspaket 5 - User Interface fiir technisch nicht versierte Nutzer

Dieses Paket war ein ein besonders wichtiges Arbeitspaket, da wir fiir unterschiedliche
Usergruppen ein geeignetes Interface anbieten wollten. Einerseits erlaubt unser Tool, direkt

Quellcode einzugeben - wie bei unserem grof3en Vorbild, der Website Shadertoy.com - was gut
geeignet ist flir versierte User; aber wir wollten auch fiir technisch weniger versierte User eine
Moglichkeit implementieren, unser Tool nutzen zu konnen. Fir diesen Zweck haben wir einen
Node Editor implementiert, der Modellierung ohne Programmierkenntnisse ermoglicht.

Das untenstehende Bild zeigt beide Arten der Eingabe: Links das Programmierinterface und
rechts der Node Editor, der keine Programmierkenntnisse erfordert - sehr wohl allerdings ein
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gewisses mathematisches Verstandnis, aber das liegt generell an der Art der Modellierung uber
parametrische Funktionen, auf die unser Tool abzielt.
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Bei der Implementierung dieses Arbeitspakets gab es zwei groRRe Herausforderungen:

1. Das Finden eines geegneten Frameworks fur den Node Editor. Alternativ haben wir eine eigene
Implementierung angedacht - doch schlussendlich konnten wir doch das JavaScript
Framework Rete.js zuhilfe nehmen.

2. Die Wahl der Abstraktion, die die Knoten in unserem Node Editor bieten, war eine
Herausforderung fur sich. Unser Tool bietet hier sowohl Knoten fiir Mathematische Funktionen
wie z.B. Sinus oder Cosinus - aber wir wollten hier noch etwas mehr Komfort bieten und das
flihrte schlussendlich dazu, dass wir auch Knoten im User Interface anbieten, die fiir sich
genommen schon parametrische Funktionen sind. Ein Knoten ist z.B. ein parametrisches Herz.
Uberdies gibt es diverse geometrische Grundformen wie z.B. eine Kugel. User kénnen diese als
Basis nehmen und nach eigenen Vorstellungen noch bearbeiten. Gleichzeitig bietet der Node
Editor nicht die volle Funktionalitat der Code Editors - doch in Summe diirfte unsere Wahl der
Abstraktion im Node Editor tatsachlich dazu flihren, dass sich User mit unterschiedlichen
Fahigkeiten und Spezialisierungen im Tool zurechtfinden.

Weitere Details Giber das User-Interface fiir technisch weniger versierte User finden sich in diesem

Blogpost:

e Einfaches User-Interface (ohne Programmierkenntnisse)

Die beiden unterschiedlichen Eingabemethoden werden noch von einem unserer studentischen
Mitarbeiter im Zuge einer Bachelorarbeit mittels User Study nach netidee-Projektabschluss
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evaluiert werden. Die Resultate konnen wir gerne bereitstellen und in einem weiteren Blog Post

zusammenfassen.

3.6  Arbeitspaket 6 - Dokumentation und Formales am Projektende
Wir haben zweierlei Dokumentation erstellt:

e Die Dokumentation fiir Entwickler ist direkt beim Source Code auf GitHub zu finden, wo
das Projekt unter https://github.com/cg-tuwien/Math2Model zu finden ist. Neben der
Dokumentation in der README.md-Datei, stellen wir noch weitere ausgewahlte relevante
Detailinformationen im /docs-Verzeichnis bereit.

e Die Dokumentation fiir User ist direkt Giber unser Tool (welches unter https://cg-
tuwien.github.io/Math2Model/ erreichbar ist) aufrufbar. Der Menlipunkt Help ->
Documentation fuhrt zur Dokumentation und bietet diverse Hilfeseiten zu den einzelnen

Teilen unseres Onlinetools.
Die weiteren erforderlichen Unterlagen haben wir direkt an netidee libermittelt.

Den Projektendbericht werden wir liber die netidee-Projektwebsite zuganglich machen:
https://www.netidee.at/math2model

3.7  Arbeitspaket 7 - Portierung der Renderingtechnik von der Desktopapplikation in die
Web-Applikation

Die Renderingtechnik, die in AP3 implementiert und publiziert wurde, wurde in die
Webapplikation portiert. Dabei wurde Riicksicht auf besondere Vorgaben und Einschrankungen
von Webapplikationen genommen und entsprechende Anpassungen vorgenommen. Wahrend
die publizierte Renderingtechnik auf Desktop-Graphikschnittstellen entwickelt wurde, ist
Math2Model ein Onlinetool, das eine Web-Graphikschnittstelle (namlich WebGPU) verwendet.
Letztere hat einige Einschrankungen im Vergleich zu ersterer, daher war es nétig, unseren
Algorithmus etwas anzupassen, um ihn im Web lauffahig und performant zu machen:

e Fir WebGPU missen wir dessen Shadersprache WGSL verwenden, die im Vergleich zu
GLSL fiir Vulkan ein paar Einschrankungen hinsichtlich der sog. Subgroup-Operationen
hat. Stattdessen verwenden wir workgroup-local memory und memory barriers.

e Unser Onlinetool unterstitzt nur die "tessellated patches" Renderingstrategie, wobei
»Software rasterization® aufgrund von technischen Einschrankungen nicht sinnvoll
umsetzbar gewesen ware (kein Support fiir atomic operations auf 64-bit Datentypen)

e DaTessellation Shader in WebGPU nicht unterstitzt sind, verwenden wir eine Art
»,manuelle Tessellation“: Wir rendern vortessellierte Quads fixer GroRen (2x2, 4x4, 8x8, ...,
32x32))
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e Furdie Patch Subdivision bendtigen wir einen Zwischenschritt um auszurechnen, wie
viele workgroups wir dispatchen miissen. Wenn wir mehr als 65535 patches in einem
subdivision Schritt haben, dann miissen die compute workgroups aufgeteilt werden.

e Esgibt einen extra Schritt vor dem Rendering, um die indirect draw counts fiirs das
Rendering zu kopieren.

e Die Patches werden in einem Speicher-effizientem Encoding abgespeichert {u: u32, v: u32}
statt { min: vec2, max: vec2 }.

Weitere Implementierungsdetails beschreiben wir in folgendem Blogpost:

e Browserprogrammierung mit einer "Desktop-Programmiersprache"

3.8  Arbeitspaket 8 - Projektverwaltung

Eine Projektverwaltung wurde implementiert werden, sodass User ihre Projekte speichern, laden
und teilen konnen. Es ist nicht notig, Nutzerkonten anzulegen - das hat zwei Vorteile: Einerseits
kann die Projektverwaltung von Nutzern ohne jegliche Hurden verwendet werden. Andererseits
ist kein serverseitiges Scripting notig, was den Entwicklungsaufwand und die Projektkosten im
Rahmen halt.

Ein Projekt besteht aus diversen Dateien, die in einem ZIP-Archiv gesammelt gespeichert oder
von einem geladen werden konnen. Durch diese Vorgehensweise ist die Projektverwaltung
einfach und transparent ohne Verwendung irgendwelcher proprietaren Dateiformate.

Projekte konnen gespeichert werden liber den Menupunkt File -> Save As.
Laden kann man ein Projekt analog dazu uber File -> Open.

3.9 Arbeitspaket 9 - Integration der urspriinglichen Math2Model Showcase-Beispiele

Beim Projektantrag haben wir ein kleines Showcase erstellt, wie das Tool aussehen kdnnte.
Enthalten waren vier Beispielprojekte. Diese Beispielprojekte haben wir in angepasster Form
auch in unser Endprojekt Ubernommen. Sie konnen geladen werden uber File -> Examples.

Dabei ist wichtig zu beachten, dass dei Beispiele teils etwas anders aussehen als im Showcase.
Das liegt einerseits daran, dass sie nun in ein allgemeines Modellierungstool integriert worden
sind, das einen gewissen Rahmen vorgibt. Das Showcase war pro Beispiel handisch adaptiert.

Einige Teile der Beispiele haben wir mittels Code Editor umgesetzt - andere iber den Node
Editor, um beide Modellierungsoptionen zu veranschaulichen und Vorlagen fur User zu bieten.

Teils war es nicht ganz einfach die Beispiele zu portieren, doch konnten wir gute Kompromisse
finden. So war etwa das ,,Turm“-Exam nicht 1:1 portierbar, weil es im Showcase ein bestehendes
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3D-Modell geladen und dieses verandert hat. Das Pendant in unserem Endprodukt beschreibt ein
komplettes Turm-Modell auf parametrische Weise.

Unsere Forderauflagen besagen, dass wir einen Teil des Projektes selbst zu finanzieren haben. Die interne
Finanzierung von Projektmitarbeitern und Studenten wurde sichergestellt.

CCBY | https://www.netidee.a
Projektzwischenbericht 4.0 t/math2model
CCBY | https://www.netidee.a
Projektendbericht 4.0 t/math2model
Entwickler_innen-DOKUMENTATION des CCBY | https://github.com/cg-
Projektergebnisses flir andere Entwickler_innen 4.0 | tuwien/Math2Model/bl
("Dritte"), die das Projektergebnis nach Projektende ob/main/README.md
nutzen/weiterentwickeln wollen
Anwender_innen-DOKUMENTATION des CCBY https://cg-
Projektergebnisses fliir Anwender_innen, die das 4.0 tuwien.github.io/Math
Projektergebnis nach Projektende nutzen wollen 2Model/docs/
Veréffentlichungsfihiger Einseiter / CCBY | https://www.netidee.a
Zusammenfassung 4.0 t/math2model
Dokumentation Externkommunikation zur CCBY | https://www.netidee.a
Erreichung Sichtbarkeit /Nachhaltigkeit: als Teil des 4.0 t/math2model
Endberichtes
Rendering von parametrischen Modellen mittels MIT | https://math2model.cg
Code und deren Rendering stuwien.ac.at/
- Online Codeeditor (dhnlich zu Shadertoy)
- Rendering von beliebigen, durch parametrische
Funktionen beschreibbaren, Objekten
- Live-Updates der parametrischen Modelle
- Rendering in Echtzeit (dank WebGPU und dessen
Compute Shader-Support)
Generierung von parametrischen Modellen mittels MIT | https://math2model.cg
einsteigerfreundlichem User Interface tuwien.ac.at/
- Einsteigerfreundlicher online Formeleditor
- Auswahl aus vorgefertigten Elementen (z.B.
parametrische Kugel, parametrisches Herz, etc.)
- Anderung der jeweiligen Parameter {iber ein
einfaches User Interface
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Generierung von parametrischen Modellen mittels
Graph
- Graphenbasierte Modellierung von parametrischen
Funktionen

(ahnlich wie Code, nur Gber Graphen, wie sie
mitunter auch in anderen professionellen
Werkzeugen zum Einsatz kommen)

MIT

https://math2model.cg
tuwien.ac.at/

10

Export der parmetrischen Modelle in ein
Dreiecksmodell

- Online erstelltes parametrisches Modell kann
exportiert werden

- Zwei gangige 3D Formate werden unterstitzt

MIT

https://math2model.cg
tuwien.ac.at/

11

Projektverwaltung

- Projekte konnen kopiert, gespeichert und geladen
werden

- Projekte konnen lber eine ZIP-Datei geshared
werden

MIT

https://math2model.cg
.tuwien.ac.at/

12

Beispiele der urspriinglichen Math2Model Showcase
Applikation in das neue WebGPU-basierte
Onlinetool integrieren

- Die urspriinglichen Showcase-Beispiele werden als
Examples in das neu erstellte Onlinetool integriert

- Die Showcase-Beispiele kénnen von Nutzern zu
Lernzwecken genutzt werden.

MIT

https://math2model.cg
.tuwien.ac.at/

Die Projektergebnisse konnen in der Praxis wie folgt verwendet werden:

e Unkomplizierte, spontane parametrische Modellierung tiber unsere Website https://cg-
tuwien.github.io/Math2Model/

e Analyse der beiden unterschiedlichen Modellierungsmethoden im Zuge einer

Bachelorarbeit. Im Zuge der Evaluierung werden die Teilnehmer einer User Study unser

Tool benutzen und dessen beide unterschiedliche Modellierungsvarianten (Source Code
und Node Editor)

e Die Anpassungen, die in Kapitel 3.7 Arbeitspaket 7 - Portierung der Renderingtechnik von

der Desktopapplikation in die Web-Applikation beschrieben wurden sind interessant fiir
die WebGPU-Community und konnen als wertvolle Richtlinien bzw. als Feedback fiir
andere WebGPU-Projekte dienen.

Die Renderingtechnik wurde wie unter 3.3 Arbeitspaket 3 beschrieben publiziert und auf der
EGPGV Konferenz prasentiert.
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Weitere Sichtbarkeit wird unser Tool durch zwei Bachelorarbeiten und eine Diplomarbeit unserer

studentischen Mitarbeiter erlangen:

Eine Bachelorarbeit wird die beiden unterschiedlichen Modellierungsvarianten evaluieren
(Programmierinterface vs. Node Editor) fiir User mit unterschiedlichen technischen
Hintergriinden.

Eine Bachelorarbeit wird den 3D-Modellexport genauer beschreiben, sowie die damit
verbundenen Optionen, Probleme und Herausforderungen.

Die Diplomarbeit wird ein nicht direkt mit Math2Model verbundenes Thema behandeln,
doch durch eine Zitation ist auch hier mehr Sichtbarkeit flir Math2Model gegeben.

Unser Tool ist online verfligbar auf der eigens eingerichteten Website:
https://cg-tuwien.github.io/Math2Model/

Dort sind samtliche Funktionen verfligbar, inklusive Projektverwaltung, Beispielen und

Dokumentation.

Ja, direkt im Anschluss an das netidee-Projektende sind folgende weitere Aktivitaten geplant:

Evaluierung der beiden unterschiedlichen Modellierungsoptionen (Code Editor und Node
Editor) in einer User Study im Kontext einer Bachelorarbeit. Die Zusammenfassung der
Ergebnise werden wir als Blog Post auf der netidee-Projektwebsite veroffentlichen.

Beschreibung der Optionen, Probleme, Herausforderungen und Eigenheiten bei der
Umwandlung von parametrischen Modellen in 3D-Modelle und beim Export derer im Zuge
einer weiteren Bachelorarbeit. Eine Zusammenfassung der Erkenntnisse werden wir als
Blog Post auf der netidee-Projektwebsite verdffentlichen.

Es gibt diverse Anregungen fiir Dritte, wie das Tool verbessert werden konnte. Hier eine kleine

Auswahl:

Implementierung weiterer Nodes im Node Editor, sodass noch mehr Bausteine out-of-the-
box geboten werden.
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e Weitere Optionen fiir die Texturierung von parametrischen Objekten, wie z.B. Support fir
mehrere Texturen (und Blending zwischen ihnen) fiir ein Objekt

e \Verbesserung der Renderingperformance in grolten Szenen: Die LOD Stage aus unserer
Renderingtechnik konnte so umgebaut werden, dass sie nicht pro Objekt separat
aufgerufen wird, sondern nur ein mal - und die so aufgerufene Compute Shader-
Hierarchie wiirde alle Objekte parallel analysieren (ahnlich wie in der publizierten
Renderingtechnik - siehe 3.7 Arbeitspaket 7 - Portierung der Renderingtechnik von der
Desktopapplikation in die Web-Applikation).

e Andiversen Stellen konnte die Nutzeroberflache noch etwas gepolished werden und die
Usability verbessert werden - wie z.B. durch Verwendung von kontrastreicheren Farben,
sodass Menschen mit Einschrankungen in der Farbwahrnehmung besser berticksichtigt
werden.

Dabei gilt es stets zu bedenken, wo sich der jeweilige Code befindet: Das Rendering Backend ist in
Rust implementiert, um auch effizientes Debugging als Desktopapplikation mittels Profiling-
Tools zu ermoglichen; die meisten anderen Komponenten sind in TypeScript implementiert, wie
z.B. der Node Editor. Uber eine eigens Implementierte Schnittstelle kommunizieren Rust und
TypeScript.

Fur externe Kommunikationsmoglichkeiten haben wir entsprechende Informationen und Links
auf der netidee-Projektseite bereitgestellt:

e Linkzuden Issues unseres GitHub Repositories fur Fragen bzgl. Entwicklung

e Linkzum Impressum unserer Forschungsgruppenwebsite fiir allgemeine/organisatorische
Fragen

Erhohung der Sichtbarkeit:

e Verwendung des Tools im Kontext von Bachelorarbeiten: Der Aufwand ist hier
hauptsachlich in der Erstellung der Arbeit, wahrend der Nutzen erhohte Sichtbarkeit
durch Verwendung und Zitation ist.

e News-Eintrag auf unserer Forschungsgruppenwebsite https://www.cg.tuwien.ac.at/ -

Nach Projektabnahme werden wir ein entsprechendes Newsitem erstellen. Unsere
Website hat durchaus eine signifikante Reichweite sowohl unter Studierenden als auch
unter externen Forschern.
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Lessons Learned:
e Die groRten Probleme in unserem Tool waren technischer Natur:
o Inkompatibilitaten zwischen Frameworks
o Schlechte bis unmoglches Debugging von TypeScript-Programmen. Die Losung
war in unserem Fall die Verwendung von Rust; aber das bringt eigene Probleme mit
sich:
= Translationslayer zwischen den beiden ,Welten®“ Rust und TypeScript
e Eine weitere Beflirchtung unsererseits ist, dass der Node Editor, der fiir technisch weniger
versierte Nutzer gedacht ist, trotzdem ein gewisses technisches Verstandnis verlangt, der

uber das rein mathematische Verstandnis hinausgeht - weitere Erkenntnisse diebezuglich
werden wir im Zuge einer Bachelorarbeit sammeln, die eine entsprechende User Study

durchfiihren wird.
o Basierend auf den Ergebnissen der User Study, sind noch diverse kleinere

Optimierungen denkbar

o Generell gilt ein Node Editor als die Standardherangehensweise in vergleichbaren
Tools - fur zukunftige Weiterentwicklungen waren ggf. auch komplett andere
Herangehensweisen interessant, falls solche gefunden werden konnen.
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